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Advanced Design in Notebook Software 
SMART Notebook Software 10 includes many new features which enable you to create lesson activities 
with a professional look.  Tables, interactive tools, and object animation will enable you to create visually 
appealing SMART Notebook files. 
 

Tables 
To add a table, complete the following steps: 

1. Press the Table button or select Insert > Table.  An eight by eight grid appears. 
2. Select the number of columns and rows that you would like to include in the table by dragging 

over the cells in the grid. 
3. The table appears on the SMART Notebook page 

 
Adding text and objects to tables 
Once you have created your table, you can add text and objects, including freehand objects, geometric 
shapes, straight lines and graphic files to the table cells simply by dragging and dropping.  To add text to 
a table cell, double-click on a cell.  A text box will appear.  To add an object to a table, select the object 
and drag it to the destination cell.  To remove an object from a table, select it and drag it out of the table. 
 
Each cell can contain only one object.  If you would like to add multiple objects to a cell, for example, an 
image and text descriptor of the image, group the objects before adding them to the table. 
 
Selecting tables, columns, rows or cells on a SMART Notebook page 
You can select a table, a column, a row, an individual cell or a selection of cells.  After you have selected 
a table or a part of a table, you can modify the properties of the selected area. 
 
Selecting a table is easily accomplished using the marquee selected method.  Use the select tool, and 
drag a rectangle to encompass the entire table. 
 
To select cells, rows or columns, press inside the table area and drag over the specific cells you would 
like to select. 
 
Moving and resizing   
To move a table on the SMART Notebook page 
or to another page, select it.  A square handle 
appears in the table’s upper-left corner.  Use 
this handle to drag the table to the desired 
location. 
 
To resize a table, select the table and press the 
resize handle in the lower-right corner of the 
table.  Drag the handle to increase or reduce 
the size of the table. 
 
Resizing columns and rows 
You can resize rows and columns by pressing 
the table lines and dragging them to adjust 
them to the preferred size.  For example, to expand the width of the first column, press the vertical line to 
the right of the column.  A double-headed arrow appears.  Drag the vertical line to the right to create a 
wider column.  You can use this method to alter the size of any row or column, but you are limited by the 
height and width of the table.  If you would like to increase the height or width of the table, drag the outer 
edge of the table to the desired height or width. 
 
Inserting or removing columns, rows or cells 
After creating your table, you can customize it by inserting or removing columns, rows and cells.  To add 
a new column or row, select a column or row, right-click and select Insert Column or Insert Row.  New 
columns will appear to the right of the selected column.  New rows will appear below the selected row. 
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To remove a column or row, select a column or row, right-click and select Delete Column or Delete Row.  
The currently selected row(s) or column(s) will be deleted. 
 
You can also delete an individual cell or group of cells from a table.  For example, when creating a 
crossword puzzle, you wouldn’t want a complete grid to appear.  To delete unnecessary cells, select the 
cell(s) you would like to delete, right-click and select Remove Cells.  
 

Magic Pen 
The Magic Pen icon from the SMART Notebook software toolbar allows you to highlight parts of 
your SMART Notebook page in a way similar to the Spotlight tool on the SMART Board interactive 
whiteboard. 

 
Magic Pen Spotlight 
Click on the Magic Pen icon on the SMART 
Notebook toolbar to activate it.   
 
Draw a circular shape on the part of the work area 
you wish to highlight.   
 
When you move your cursor over the magic 
shape, it turns into a double-ended arrow.  This 
arrow allows you to make the highlighted area 
larger or smaller. 
 
 
 
 
 
 
 
Magic Pen Zoom 
When you use the Magic 
Pen and draw a rectangle 
around an area on your 
SMART Notebook page, it 
will allow you to zoom into 
that area. 
 
When your cursor 
approaches the magic 
shape, it turns into a hand.  
This hand allows you to 
move the magic shape to 
zoom or highlight a different 
selection.  The double-
ended arrow allows you to 
resize the zoom or highlight 
area. 
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Object Animation 
You can add excitement to your lesson activity and 
emphasis to key points by using Object Animation.  You 
can animate an object to fly in from the side of the page, 
spin, fade in, shrink and more, choosing when the 
animation takes place, at what speed and for how long.  
You can add animation to a text object or any object 
created with the Shapes tool or any of the pen tools. 
 
To animate an object, complete the following steps: 

1. Select the object you would like to animate 
2. Open the Properties tab 
3. Select the Object Animation tab 
4. Using the drop-down lists provided, select the 

animation Type, Direction and Speed 
5. Select the animation timing from the Occurs drop-

down list.  You can set the animation to take place 
when you enter the page or when you click the 
object. 

6. Select how many times the animation repeats 
from the drop-down list. 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



  5 

Review: Advanced Design in Notebook Software 
 

1. How do you move a table? 
 
 
 
 
 
 
2. How do you add a cell or table shade? 
 
 
 
 
 
 
 
3. What are the functions of the Magic Pen? 
 
 
 
 
 
 
 
4.  What are the features of Object Animation? 
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Integrating Rich-Media into Lesson Activities 
There are many ways that you can take advantage of various types of rich-media when creating lesson 
activities with SMART Notebook collaborative learning software and a SMART Board interactive 
whiteboard. 
 
Using the interactive whiteboard to complete research on the Internet transforms research from an 
individual activity to a whole class activity.  SMART Technologies even provides a list of websites that 
work well with a SMART Board interactive whiteboard.  This list can be found at 
Education.smarttech.com > Educator resources > Online classroom resources. 
 

Page Recorder 
Using the Page Recorder, you can record any actions completed 
on the current SMART Notebook page, including writing with 
digital ink, adding and modifying objects, and creating shapes.  
This recording is saved as a part of the SMART Notebook file and 
can be replayed at any time from that SMART Notebook page.  
The Page Recorder enables you to record an example of an 
activity or problem to replay when using the lesson activity in 
class.  If students are working independently at the interactive 
whiteboard, they can view and re-view instructions and examples 
without seeking the help of the teacher. 
 
To record actions on a SMART Notebook page, complete the 
following steps: 

1. Open the Properties tab 
2. Press the Page Recording button 
3. Press the Start Recording button 
4. Complete any actions on the SMART Notebook page that you would like to record 
5. Press Stop Recording 

A page recording toolbar appears at the bottom of the SMART Notebook page, which enables you to play 
and pause the recording from this SMART Notebook page at any time.  You can also play recordings by 
pressing the Play button found in the Page Recording section of the Properties tab. 
 

SMART Recorder 
With SMART Recorder, you can make a video recording of your lesson, no matter which applications you 
are using on the interactive whiteboard.  If you have a microphone attached, you can also record your 
voice.  For example, this feature enables you to record sample math problems, incorporating the use of 
the on-screen calculator or spreadsheet, then replay the file as a review for you students or for those who 
missed the lesson.  Recording can be played using SMART Video Player or Windows Media player. 
 
To record actions on the SMART Board interactive whiteboard, complete the following steps: 

1. Press the Record button.  By default, SMART Recorder 
records the entire workspace, although you can modify this 
setting. 

2. Complete the actions you would like to record 
3. Use the Pause and Record buttons throughout the 

recording as required 
4. Press the Stop button to end the recording 
5. You will be prompted to save the file.  Select a location, 

name the file, and press Save 
6. The Recording Complete dialog box appears, providing details of the recording, including file 

size and recording time. 
7. If you would like to immediately view your recording, check Play Recording 
8. Press OK 
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Hiding the SMART Recorder 
If you do not want the SMART Recorder to be visible in the 
recording, or you don’t want it to distract your students, you can 
hide it in the notification area. 
 
To do this, press the Menu button and select Hide to System 
Tray.  Click on the SMART Recorder icon to access a menu 
providing you the same access to Record, Pause, Stop, and other 
features of Recorder.  Select Show to restore the SMART 
Recorder to full size. 
 
Setting the recording area 
SMART Recorder has three options for the region of the workspace 
that will be recorded.  Selecting a smaller recording area will reduce 
the file size and can eliminate distractions from the recording, such 
as the task bar or any applications that are open but not necessary 
for the lesson. 
 
To specify the portion of your desktop that you would like to record, 
press the arrow beside the Record button, and select from the 
following three options: 

 Record Desktop (Default) – Records the entire desktop 
 Record Area – prompts you to select the area of the screen 

you would like to record 
 Record Window – Prompts you to choose a window that you would like to record 

 
SMART Recorder Menu 
The SMART Recorder Menu button provides 
access to several options and settings that you 
can modify to make SMART Recorder work 
best for you.  To access these settings, select 
Options from the Recorder Menu to launch 
the Options dialog box. 
 
The Recording Quality tab enables you to 
adjust the quality levels of the sound and video 
recorded, which also has an impact on file 
size.  For example, you can change the 
number of frames per second you record.  
Movies recorded at a low frame rate have a 
smaller file size than those with a higher frame 
rate, but the visual quality of the movie is 
reduced. 
 
The Video Format tab allows you to choose a 
file format to save your movie.  The Windows 
Media Video Files option creates a file that can 
be viewed with Windows Media player.  The 
SMART Recorder Video option creates a more 
compressed file, resulting in a smaller file size.  
This file can be viewed only if SMART Board 
software is installed on the computer playing 
the video. 
 
Select the Target Files tab to change where your Recorded file is saved on your computer. 
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The Watermark tab enables you to add an image or text watermark to your recording, which would be 
visible anytime the file is played.  You could use this feature to include course or unit titles, the date of the 
lesson or your school’s logo.  You can adjust the placement of the watermark on the recording, and the 
font size, style and transparency of the watermark.  You can also set a standard watermark to use each 
time you create a recording or select Turn off watermark when SMART Recorder closes to revert to 
using no watermark. 
 

SMART Video Player 
With SMART Video Player, you can play video files located on your computer or an external device, such 
as a camera, VCR, CD-Rom, DVD player or document reader. 
 
Although other video players work on a SMART Board interactive whiteboard, when you are using 
SMART Video Player, you can write over the video, whether it is moving or still.  The transparency layer 
does not appear over SMART Video Player when you pick up a pen tool from the pen tray.  With other 
video players, the transparency layer appears, and the video seems to be paused while you are writing.  
However, it actually continues to play in the background and you miss portions of the video. 
 
If you are writing notes you would like to save for later use, you can write over a frame of video and 
capture your notes to SMART Notebook software. 
 
To launch SMART Video Player, click the SMART Board icon in the notification area and select Video 
Player.   
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SMART Video Player has an easy-to-use button interface that enables you to play and pause video, and 
set your preferences for using digital ink with the SMART Video Player. 
 
Button 
 

Use this tool to 

 
Show how much time is remaining in a movie 

 

Play or pause the movie 

 

Stop the movie and rewind it to the beginning.  
When using the pen tool, this button changes 
to a Clear Screen button, enabling you to 
remove any notes written over the video. 

 

Capture the current frame to SMART Notebook 
software 

 

Return the mouse to cursor mode 

 

Use the cursor as a pen tool 

 

Change the color of the digital ink 

 

Change the line thickness of the digital ink 

 

Clear any notes written over the video 

 

View the video in full-screen mode 

 

Set the video to repeat continuously 

 

Mute the sound 

 
Adjust the volume 

 
Play list 
SMART Video Player has a play list feature that enables you to prepare and save a list of videos to use in 
your lesson.  To view the play list, select View > Show Playlist.  To add a file to the play list, press the 
Play List button and select Add.  You can also reorder and remove files from the play list.  To save the 
play list for future use, press the Play List button and select Save.   
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Video Player Settings 
As there are many different potential uses for the 
SMART Video Player, there are several settings 
that you can change to customize the way that the 
Video Player works and responds to your actions, 
including the video playback speed, what happens 
when you pick up a pen tool and how long any 
notes you make are displayed on the screen. 
 
To access the Video Player Settings dialog box, 
select Settings > Video Player Settings. 
 
Pause while writing 
The default setting for Video Player is to pause 
whenever you pick up a pen tool.  With this setting, 
you can stop the video, make notes and lead a 
discussion with your students.  When you are 
ready, you can put the pen down to continue 
watching the video.  Alternatively, you can deselect 
the Pause when tool(s) lifted check box, changing 
the settings so that the video continues to play 
when you are using the pen tool.  This action 
enables you to highlight important points on the 
screen without interrupting the flow of the lesson. 
 
Fading out annotations 
As the video plays, you might want your notes to disappear without having to press the Clear Screen 
button.  To enable or disable the Fade out notes option, complete the following steps: 

1. Select or deselect the Fade out notes check box 
2. Designate the amount of time (in seconds) that should pass before the digital ink begins to fade 

and how long it should take to clear the screen 
3. Press OK 

 
 
    
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 



  11 

Review: Integrating Rich-Media into Lesson Activities 
 

1. List examples of how you would use the Page Recorder. 
 
 
 
 
 
2. List examples of how you would use the SMART Recorder. 

 
 
 
 
 

3. List examples of how you would use the SMART Video Player. 
 
 
 
 
 
4. How do you launch the SMART Video Player? 

 
 
 
 
 

5. What are the setting options for the SMART Video Player? 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



  12 

Importing a file with SMART Notebook Print Capture 
SMART Notebook Print Capture is a printer driver installed with SMART Notebook software that imports a 
file or specified pages of a file into the SMART Notebook file.  Each page of the imported file appears as 
an object on its own SMART Notebook page, with its original formatting and page breaks preserved.  This 
feature is different than Capture to SMART Notebook software, because it enables you to import full 
pages, page ranges and files, not just the visible work area. 
 
You can import Microsoft Word software documents or any other type of documents that you would 
normally be able to print.  This feature is particularly useful if you have existing electronic resources, but 
you would like to take advantage of the interactivity that SMART Notebook software enables.  You can 
import worksheets and documents that you would normally transfer to an overhead transparency.  You 
can also use this feature to save examples of students’ work in one convenient SMART notebook file.   
 
To import a file using print capture, complete the following steps: 

1. In the source application, select File > Print.  The Print dialog box opens. 
2. Select SMART Notebook Print Capture from the list of printers 
3. In the Print dialog box, select a page range 
4. Press OK 

 
Changing the properties of the SMART Notebook Print Capture driver 
When you import a file with SMART Notebook Print Capture driver, each page appears as an image on 
its own Notebook page.  Just as with any printer driver, you can change the page orientation and 
additional print properties. 
 
To change the page orientation, do the following: 

1. In the source application, select File > Print.  The Print dialog box opens. 
2. Select SMART Notebook Print Capture from the list of printers 
3. Press the Properties button.  The SMART Notebook Print Capture Properties dialog box 

opens 
4. Select Landscape orientation or Portrait orientation 
5. Press OK 

 
Delivering Lessons and Leveraging Interactive Tools 
The best way to prepare yourself for delivering your lessons on a SMART Board interactive whiteboard is 
to create well-organized SMART Notebook software lessons. 
 
An organized, well-designed lesson will enable the following: 

 Smooth and effective navigation from page to page 
 Clear and concise presentation of lessons content 
 Increased flexibility to address student needs 
 Clear expectations of what students or substitute teachers are to do during a lesson activity 
 Lesson activities that perform as intended 
 Minimal transition time between documents or activities, resulting in more effective classroom 

management 
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Customizing SMART Notebook Software for Effective Lesson Delivery 
Teachers with a sophisticated delivery style don’t distract their students from the lesson by searching for 
the tools they need.  Customize the SMART Notebook interface to put all the tools you need for your 
unique delivery style at your fingertips. 
 
Customize the Floating Tools toolbar 

The Floating Tools toolbar provides instant access to interactive tools that will help you deliver 
amazing lessons whether you are using SMART Notebook software or another application on the 
SMART Board interactive whiteboard. 
By default, the Floating Tools toolbar in anchored to the left-hand side of the interactive 
whiteboard.  If you are right-handed and find yourself needing to access it frequently while writing 
and navigating, you may wish to drag this toolbar to the right-hand side of the screen before 
beginning your lesson. 
 
Customize the properties of the tools that have side menus to minimize delivery time spent setting 
them up to be useful for your lesson.  Press the Customize button on the side menu.  The 
Properties dialog box will appear where you can change the settings for the tool. 
 
You can save the new settings so they become the default for that tool by clicking the Save Tool 
Properties button at the bottom of the dialog box after you’ve set the parameters above.  
 
Customize your Floating Tools toolbar so that it contains all the tools you find yourself 
using frequently in your lesson delivery. 
 
 

Press the Customize button in the Floating Tools toolbar to choose from a variety of 
toolbar icons.  You can choose as many icons as you like to fully customize this toolbar 
with the tools you need most often. 
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Placement of the toolbar 
By default, the toolbar in SMART Notebook software is located at the top of the workspace.  This is the 
most accessible location for teachers and older students to use the tools.  If young students or students 
with mobility concerns are using the SMART Board, you may need to move the toolbar to the bottom of 
the workspace for easier reach.  To move the toolbar from the bottom of the workspace, or vice-versa, 
press the double-sided arrow icon. 
Placement of the side tabs 
By default, the side tabs appear on the right-hand side of the workspace.  These can be moved to the 
opposite side of the workspace by pressing the double-sided arrow icon.  To facilitate your lesson 
delivery, it is best to place the side tabs on the side of the board where you tend to stand when delivering 
your lessons.  Left-handed presenters may find the side tabs more accessible on the left side of the 
workspace, whereas right-handed presenters may find the side tabs more accessible on the right side of 
the workspace. 
 

Presentation Tips for Delivery on an Interactive Whiteboard 
Body positioning 

 Face your students as much as 
possible while manipulating the 
SMART Board interactive 
whiteboard 

 When you need to reach 
something on the other side of 
the interactive whiteboard, 
move to the other side of the 
board so that you can still 
reach with the hand closest to 
the board, maintaining an open 
body position 

 Keep your frame as open as 
possible and turn to face the 
audience when discussing the 
points you have written 

 
Touch tips 

 When manipulating an 
interactive whiteboard, it is 
most effective to position your 
hand either above or below the 
object you wish to move or 
touch, rather than touching it 
straight-on. 

 This hand position keeps the 
object you are touching visible 
to the audience while you are 
manipulating it.  It also prevents 
your hand’s shadow from 
blocking small items such as 
navigation buttons, making 
them hard to see and touch 
accurately 

 
Writing tips 

 Press with intent, applying constant pressure, when writing.  
Don’t worry, you won’t damage the board. 

 Write in large letters.  Users with a characteristically small 
writing style will be most happy with their attempts to write on an 
interactive whiteboard if they practice increasing the size of their 
text. 
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 Avoid resting the heel of your hand on the surface of the whiteboard while you are writing 
 Don’t be afraid to use different colors to enhance your delivery – that is why SMART provides you 

with an array of pen-tray pen tools instead of only one. 
 Choose a color that will contrast with the background.  On a dark background such as a video, 

red is a good color choice.  

Ad-hoc Lesson Delivery 
As a teacher, you know that it is sometimes desirable to deviate from planned lessons in order to manage 
your classroom as effectively as possible.  The following are examples of spontaneous lesson creation 
that are often necessary: 

 Enrichment tasks for students who finish early 
 Transition activities for in-between time 
 Impromptu explanations or demonstrations 
 Extensions onto planned lessons 
 Unplanned review of previous material 

 
SMART Notebook collaborative learning software has a number of tools to help you with these types of 
ad-hoc lesson situations.  This section outlines several ideas to give you something to draw upon when 
you need a spontaneous lesson activity or lesson component. 
 

Ad-hoc Lesson Ideas for SMART Notebook software 
The lesson ideas in this section have been selected based on the following characteristics of effective ad-
hoc lessons: 

 Minimal transition and setup time 
 Set up is interactive and purposeful 
 Activity furthers desired student learning outcomes 

 
Lesson Activity Toolkit 
The Lesson Activity Toolkit is included as an option when installing SMART Notebook software.  This 
toolkit adds content to the SMART Notebook software Gallery to aid teachers in creating planned and ad-
hoc lesson activities. 

 
 
Use of the Lesson Activity Toolkit’s Random 
domino generator for an impromptu math 
activity.  
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Create some education games ahead of time 
Make and collect a library of education games based on the topics you will be covering throughout the 
year.  The Lesson Activity Toolkit has an array of templates for popular games and activities created in 
Flash software.  Crossword puzzles, matching games, trivia, anagrams, word-guess games and more can 
be easily created by inputting your own lesson content. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Preparing these types of games requires a little bit of work ahead of time, but having a collection to draw 
upon as a filler activity or enrichment task is invaluable when the need arises. 
 
Relevant education games or interactive activities are also a powerful and fun way for any age group to 
review material or start a lesson. 
 
Use ready-to play strategy games 
To ensure that the game-play in your classroom is relevant to your specific student learning outcomes, 
the majority of the education games included in the Lesson Activity Toolkit require you to add your own 
content.  However, several ready-to-play strategy games are also included with the Toolkit to aid you with 
impromptu classroom activities.  Sudoku, chess and checkers are useful for teaching children strategy 
skills and, if used judiciously, can be an effective enrichment task for small groups of students. 
 
Develop a collection of favorite websites 
Develop a page in a separate SMART Notebook software file that houses a collection of your favorite 
education websites.  Students can browse these websites on the SMART Board interactive whiteboard in 
small groups, or as a class, when there is a spare moment. 
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The Value of Assessment 
By using diagnostic, formative and summative assessment frequently and effectively in the classroom, 
you are able to set your students up for success. 
 
Diagnostic Assessment 
Diagnostic assessment is a way of determining the knowledge and skill levels of your students before 
beginning a lesson.  These typically ungraded results will assist you in developing a learning plan that will 
work with the strengths and weaknesses of the students as reflected by this prelearning assessment.  
 

 What forms of diagnostic assessment have you used in the past? 
 
 
Formative Assessment 
Regular use of formative assessments throughout a lesson will ensure that students have stayed on track 
with the expectations laid out in the beginning of a lesson.  Rather than leaving a final test at the 
completion of a unit, chapter, year or semester to judge if they have absorbed the information required, 
conducting regular and ungraded assessments of knowledge and skill throughout a lesson will set up 
students for graded success.  Results found by formative assessments can be addressed on a one to one 
basis or in a group as required and best determined by the educator. 

 What forms of formative assessment have you used in the past? 
 
Summative Assessment 
A summative assessment is typically used to award a grade at the completion unit, semester or year to 
determine if a student’s knowledge and skill level is where it would be expected to be at that point.  A 
series of activities and questions are completed to test a variation of abilities.  The results of many 
summative assessments are fairly high stake as they affect students’ grades, but they also are used for 
the accountability of the school itself.  By using technology in the way outlined for both diagnostic and 
formative assessments, students will be set up for success when the time comes for graded 
assessments. 
 

 What forms of summative assessment have you used in the past? 
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